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Installation, migration, upgrade, and configuration 
information 

Installation notes 

Incorrect values for cell and node displayed during install
During install, the user is asked to provide the cell and node names. Typically, these are just the 
hostname of the computer. However, these values default to the fully-qualfied hostname (e.g., 
hostsystem.ibm.com) when the value should actually be the hostname excluding the domain (e.g., 
hostsystem). 

Install produces "Invalid Directory" error in Rich Client path
If you encounter this "Invalid Directory" error, specify the root directory name of IBM Workplace Rich 
Client 

"Invalid Server" error entering fully-qualified domain node name
if you encounter this "invalid Server" error, find the correct cell and node names in the 
<WCS/WSE>/AppServer/config directory. 
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Known limitations, problems, and workarounds 

Limitations 

'Save As' function in Form editor not working
The "Save As" function for the Form editor (available from the context menu and File menu) is not 
working in the current release of Workplace Designer. 

Accessibility: CTRL+F10 fails to show view menu in shelf Part
In the Data Navigator and UI Control View, using standard CTRL+F10 Keyboard commands doesn't 
display the view menu part. 

Accessibility: Jaws is announcing a table as a list box
Access privileges are not being read as a table by Jaws; instead, the table is being announced as a list 
box. This is a Jaws issue, and can be considered a third-party defect. 

Color Palette is not accessible 
Designer is using the standard SWT color palette which ultimately uses the one coming from the 
Windows OS, which is not accessible. 

Directory searches do not support wildcards
The current version of the IBM Workplace Designer Directory Service package does not support regular 
expressions in search filters (e.g., wildcards). 

Discussion Sample App: Inconsistent no. of items listed in page
On pages with hierarchical views of discussion topics, more topics may be displayed than is expected. 
This is due to Response documents of topics being displayed, which are not counted towards the total 
desired topic display count. 
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Error dialog created by Eclipse is not accessible
Whenever Designer can, it uses its own version of a dialog that is solving the issue. But in this case, the 
message dialog is thrown by Eclipse automatically without Designer being able to intercept it. This is 
related to a broader Eclipse limitation where the Image in a standard Eclipse message dialog does not 
contain Alt+Text information. 

Note: For this specific issue, the error is expected to be fixed in a subsequent release. 

Exported component renaming
If you need to import a component that was recently exported, the name will need to be changed; 

otherwise, a "File already exists" error will be displayed.


There cannot be duplicate component names. 

Form with a background image is not shown on the server
The option to create an image as a form background is not available. 

Non-Visible UI Control Label is shown at runtime 
This issue occurs as in the following scenario: 

z Create a new form 
z Insert a control 
z In the 'Basics' properties set Visible to "False". 

Deploy the component and, at runtime, the Label for the control appears. 

Richtext control with "Store as Attachment" shows no filename 
If a richtext control is placed on a form with the 'Store as Attachment' option checked on the Basics tab, 

you must also specify a filename, or else a deployment error will occur when the user deploys the 

component. The UI currently allows the user to not specify a filename.


You must specify an attachment file name to deploy with the 'Store Data as Attachment' option. 

Standard Eclipse pop-up is not read correctly by screen reader
The standard Eclipse pop-up that allows view and perspective navigation control (CTRL+F6 / CTRL + F7) 
is not read correctly by screen reader; this is an Eclipse bug that should be fixed in the next release. 
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Standard Eclipse progress bar not being read by screen reader
The standard Eclipse progress bar status is not being read correctly by screen reader; this is an Eclipse 
bug that should be fixed in the next release 

Title area of standard Eclipse Preference page
The Title area of the standard Eclipse Preference page is not responding to font changes, and is using a 
hard-coded image as a background. This is an Eclipse bug that should be fixed in the next release. 

Truncation occurs in some dialog boxes in high contrast settings
Truncation occurs in some dialog boxes when high contrast settings are used. This is caused by an 
Eclipse dependency, and is expected to be fixed in the next release. 

Wrong icon when Designer and Managed Client both open
When both IBM Workplace Designer and IBM Workplace Managed Client are open, the wrong icon 
displays in the IBM Workplace Designer tab. This is an issue with Eclipse. 

"Import Documents" from Import Domino form not supported
The ability to import documents from the Import Domino form is not available in this release. 

Known problems and workarounds 

Background/Border not showing for check box and radio button
The background color and border is not displaying for checkboxes and radio buttons in Mozilla and 
Firefox. This can be considered a third-party defect: 

https://bugzilla.mozilla.org/show_bug.cgi?id=183247.

https://bugzilla.mozilla.org/show_bug.cgi?id=150176


Border formatting changes not appearing in deployed apps
When you create a component, add a control, click the Format properties tab, then set border properties 
for the control, those border properties are not appearing when the component is deployed and viewed as 
an application. 
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Border not appearing for images in deployed apps
When you add a border around an image control, the border is not appearing when the component is 
deployed and viewed as an application. 

Cannot copy and paste a view control
In the current release, you cannot copy and then paste a view control either on the same form or onto a 
different form. 

Cannot create schemas with multiple root elements
Designer does not handle schemas with multiple root elements properly. 

Cannot delete a control just dragged to the form
After dragging a control from the Control Palette area to the form, the Palette will retain focus. To give 
keyboard focus to the form, either click in the form or on the form's table; you will be able to delete the 
control you just created. 

An alternate way to create controls using the palette, that does not leave focus in the palette, is to click on 
the control you wish to create, and then click on the form where you wish to put the control. 

Cannot import a Domino database with non-ASCII chars
Domino databases containing non-ASCII characters cannot be imported. Rename the Domino database 
.nsf file to some other name, and then import the database. 

Component fails to run when running on a Linux/DB2 server
When running a component on a Linux Workplace Server with a DB2 database, you may encounter an 
error that looks like this: 

IBM Workplace Designer Runtime Error


com.ibm.workplace.designer.docdb.TDBException : Document id '3f7dbac2f4ee3' 

does not exist in database 'ProjectManager_pop'


Java runtime exception

XSP Page name : DepartmentProjectStatus

HTML Tag ID : XSP_7_0_12L_XSPPageContainer0

XSP Bean : 

com.ibm.workplace.designer.xsp.components.XSPBeanXmlDocument/document

XSP Event : com.ibm.workplace.designer.xsp.event.MainHtmlEvent
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This may be due to a missing DB2 JAR file (db2jcc.jar). To correct the problem, do the following: 

z	 Log into the WAS admin console 

z	 Navigate to Servers->Application Servers->WebSphere_Portal->Process Definition->Java Virtual 
Machine 
You should see a Classpath property that already contains a path to db2java.zip. Add an entry for 
db2jcc.jar in the same directory as db2java.zip 

z	 Restart the server 

DB2: Deleting many designer documents fails
Deleting a large number of documents can fail if the DB2 transaction log is full. The error will look 

something like this:


Exception while while calling method DBDatabase.removeAllDocuments()
Error while removing all documents from database 'WorkloadTestRig' 

The transaction log for the database is full. SQLSTATE=57011 

This can be resolved by increasing the size of the DB2 transaction log using the following: 

z	 DB2 connect to <database> user <username> using <password> 
z	 DB2 update db cfg for <schema_name> using LOGFILSIZ <new_log_file_size> 

Deleting a component does not always remove it from Comp Nav
Sometimes when you delete a component, the component will not be removed from the Component 

Navigator. This is an intermittent problem.


To work around this issue, restart Designer, at which time the deleted component no longer appears in 

the Component Navigator.


Deployment error message is too general when bad username
When there is an authentication error during deployment (e.g., caused by a bad Workplace username), a 
generic error message is displayed requesting that the user see the error logs for details; this error 
message will be made more specific in a later release. 

To determine whether the error is caused by a bad username, please look in the error log for the server 

response text (in XML format) which describes the deployment error.


Designer Runtime install UI does not default to WSE
With WSE installed, starting the Designer Runtime install UI, the field "Installation location of IBM 

Workplace Collaboration Services Server" does not default to the actual installation location of 

'WorkplaceServicesExpress'.


Workaround 
Manually enter the WSE installed location in the above field. 
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Designer Table added to a form does not display
A table on its own is just a layout, and does not have any visible areas. If there is no border set on the 
table, or if there are no controls put inside the table, it would not be displayed in deployed applications. 

Workaround 
Set the border on the table, or put controls in the table cells. 

Discussion Sample App: Author field on Response doesn't change
When filling out a Response document to a topic in the discussion database, the Author field may not get 
appropriately set. 

Discussion Sample App: Large file attachment error
Based on the way the web server is configured, users may experience errors when uploading very large 
files using the File Upload control. 

Don't place two instances of the same component on the same page
Two instances of the same Designer component placed on the same page will cause navigation 
problems when editing or viewing documents. 

Edit box needs binding for default value to work
Default value for an edit box is not working when the edit box is not bound to a schema field; a schema 
field is required for this to work. 

Fonts set in Designer are not seen in the deployed apps
If any font set for any control in Designer is not available in the Client machine where the Portlet page is 
seen, then the target browser (Client browser) will subsititute its own default font. 
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Importing the sample applications
There are no instructions for how to import the sample applications into Workplace Designer. 

Workaround 
Perform the following steps to import the sample applications into Workplace Designer: 
1. Click File > Import > Component. 
2. In the Import Workplace Component dialog box, click Browse. 
3. Navigate to one of the following directories:
z	 [WMCInstallDir]\applications\eclipse\plugins\com.ibm.workplace.designer.sampleApps_1.0.0\sam 

pleApps (Microsoft® Windows®) 
z	 [WMCInstallDir]/applications/eclipse/plugins/com.ibm.workplace.designer.sampleApps_1.0.0/sam 

pleApps (Linux™). 

Note: [WMCInstallDir] is the directory where the IBM Workplace Managed Client is installed.


4. Select one of the following .JAR files, and then click Open.
ProjectManager.jar 
DiscussionDatabase.jar 
ContactList.jar 
Blog.jar 

5. Click OK. 

Installer reports success, but logs indicate failures
If you are seeing failures indicated in your log files after the installer has reported a successful 
installation, please look at the InstallLog[1-5].txt and InstallErr[1-5].txt files in the Designer directory. If 
you don't see "Application LWP_Designer_Runtime installed successfully" at the end of InstallLog5.txt, it 
means that deployment of the Designer .ear file has failed. Manual deployment may be necessary 

Link Control in runtime gives error when URL option is selected
If the link control references is a website link (URL), then the standard, accepted way for entering the 
URL is of the format http:// or ftp://. Also, if the referenced file exists in the workspace, the absolute or 
relative location of the file can be entered. 

Linux: "Select a directory" dialog in install does not work
When using an InstallShield implementation, to select /opt/WebSphere, you need to open the /opt 
directory, select WebSphere, and click Open. 

If you open /opt/WebSphere, and enter "WebSphere" in the filename field, the InstallShield mistakenly 
believes you have entered "/opt/WebSphere/WebSphere", which does not exist. 

Mozilla: Borders not displayed for Rich Text in deployed apps
In deployed applications, borders are not appearing properly at Runtime for Rich Text Control, in Mozilla 
and FireFox; in Internet Explorer, they are displayed properly. 

Workaround 
In Workplace Designer, set the height of the Rich Text control to be equal to or greater than 220px. 
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No properties available after creating a new control
When a new control is dragged-and-dropped onto a form, the Properties panel will display "No properties 
available." This is because the Controls palette still has focus. To view the properties of the control, click 
on the control or the window tab of the form, which will give the form focus. 

This problem only occurs when you drag and drop a control on the form, not when you click the control in 
the palette, and then click on the form to create the control. 

Proj Mgr Sample App- Delete buttons do not give a warning dialog
This issue applies to the Project Information/Project Edit page. When a user selects the checkbox next to 
the issue, and clicks the Delete Issue button, they may not receive a confirmation dialog. 

Project Mgr Sample App: Intermittent runtime error
If a large component is imported and immediately deployed, a runtime error may occur. To workaround 
this problem, the importer should wait briefly for some Designer runtime import mechanisms to complete 
their cycles. 

Project Mgr Sample App: Typo in the isForTesting field
When users answer "Yes" to the 'Application Is For Testing' query on instantiation of the Project Manager 
application, the resulting document autogeneration dialog prompt may refer to generating contacts 
instead of generating projects and issues. 

Radio button without schema gives error in runtime
Placing a radio button on a form without associating the radio button with a schema element gives an 
error at runtime. 

Workaround 
Define a schema element for that radio button. 

Sample-Blog-Admin role has Author role access instead of Editor
Users set up with Administrator rights instead of Author rights in a template or application which includes 
the Blog sample application may find their privileges restricted to Author access. Users with Author 
access are unable to edit blog properties or post new blog entries. 

Script editor doesn't open via Error tab
Double-clicking an error on the Error tab for a form property script does not open the script editor where 
the error is located. 
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Script errors don't show in Error tab
Errors for scripts entered on the Data tab for Forms do not show up on the Error tab. 

Scripting not being deployed
If your scripts are not being deployed to your server and your System.err file (located in your runtime 
workspace) is showing the following exception: 

java.lang.ClassCastException: 
com.ibm.workplace.des.formtools.ui.table.LWPTableControl 

at 

com.ibm.workplace.des.formtools.ui.panel.XSPControlRuntimeFormatter.contribute

ToRuntimeFormattingSession(XSPControlRuntimeFormatter.java:60)


at 

com.ibm.workplace.des.ide.model.ide.provider.IControlModelItemProvider.contrib

uteToRuntimeFormattingSession(IControlModelItemProvider.java:1058)


at 

com.ibm.workplace.des.ide.model.ide.provider.IContainerControlModelItemProvide

r.contributeToRuntimeFormattingSession(IContainerControlModelItemProvider.java

:340)


at 

com.ibm.workplace.des.formtools.ui.form.layout.provider.ITableModelItemProvide

r.contributeToRuntimeFormattingSession(ITableModelItemProvider.java:488)


at 

com.ibm.workplace.des.ide.core.rtformat.BaseRuntimeFormattingSession.processMo

delPart(BaseRuntimeFormattingSession.java(Compiled Code))


at 

com.ibm.workplace.des.ide.core.rtformat.BaseRuntimeFormattingSession.processMo

delPartList(BaseRuntimeFormattingSession.java(Compiled Code))


at 

com.ibm.workplace.des.formtools.ui.form.layout.provider.IFormModelItemProvider

.contributeXSPToRuntimeFormattingSession(IFormModelItemProvider.java:1092)


at 

com.ibm.workplace.des.formtools.ui.form.layout.provider.IFormModelItemProvider

.contributeToRuntimeFormattingSession(IFormModelItemProvider.java:884)


at 

com.ibm.workplace.des.ide.core.rtformat.BaseRuntimeFormattingSession.processMo

delPart(BaseRuntimeFormattingSession.java(Compiled Code))


at 

com.ibm.workplace.des.ide.core.rtformat.BaseRuntimeFormatter.createRuntimeForm

at(BaseRuntimeFormatter.java:190)


at 

com.ibm.workplace.des.ide.model.design.PersistedEMFMediator.doSave(PersistedEM

FMediator.java:321)


at 

com.ibm.workplace.des.formtools.ui.form.design.FormPersistedMediator.doSave(Fo

rmPersistedMediator.java:177)


at 

com.ibm.workplace.des.ide.model.design.DesignTimeModelController.buildModelIns

tance(DesignTimeModelController.java:211)


at 

com.ibm.workplace.des.ide.core.resources.LWPDBuilder.buildFiles(LWPDBuilder.ja

va:152)


at 

com.ibm.workplace.des.ide.core.resources.LWPDBuilder.fullBuild(LWPDBuilder.jav

a:102)
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at 

com.ibm.workplace.des.ide.core.resources.LWPDBuilder.build(LWPDBuilder.java:76

)


at 

org.eclipse.core.internal.events.BuildManager$2.run(BuildManager.java:564)


at 

org.eclipse.core.internal.runtime.InternalPlatform.run(InternalPlatform.java(I

nlined Compiled Code))


at org.eclipse.core.runtime.Platform.run(Platform.java(Compiled Code))

at 


org.eclipse.core.internal.events.BuildManager.basicBuild(BuildManager.java:157

)


at 

org.eclipse.core.internal.events.BuildManager.basicBuild(BuildManager.java:249

)


at 

org.eclipse.core.internal.events.BuildManager.basicBuild(BuildManager.java:202

)


at 

org.eclipse.core.internal.events.BuildManager$1.run(BuildManager.java:229)


at 

org.eclipse.core.internal.runtime.InternalPlatform.run(InternalPlatform.java(I

nlined Compiled Code))


at org.eclipse.core.runtime.Platform.run(Platform.java(Compiled Code))

at 


org.eclipse.core.internal.events.BuildManager.basicBuild(BuildManager.java:232

)


at 

org.eclipse.core.internal.events.BuildManager.basicBuildLoop(BuildManager.java

:268)


at 

org.eclipse.core.internal.events.BuildManager.build(BuildManager.java:297)


at 

org.eclipse.core.internal.events.AutoBuildJob.doBuild(AutoBuildJob.java:155)


at 

org.eclipse.core.internal.events.AutoBuildJob.run(AutoBuildJob.java:212)


at org.eclipse.core.internal.jobs.Worker.run(Worker.java:66)


then you have a corrupt cache registry file. 

The path of this registry file, relative to the runtime workspace of the user, is 
".config\org.eclipse.core.runtime\.registry.1". Renaming or deleting the cache registry file will solve the 
problem. 

Space taken by invisible rows
When you add Visible logic to a row in a table, the row data will be invisible, but the empty space will still 
be there in the table. 

To simulate hiding the row, you can create multiple tables and add the row that needs to be hidden in a 
seperate table. You can then set the Visible attribute as 'False' on that table and on any paragraphs 
between these tables. This would make the extra space go away. 
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Style category missing in Format of Form and UI controls
If any style category is missing in the list box of the Format tab for a control, check the selection of that 
particular style category in the Styles table shown in the Component format tab. 

For example, click on the component name in the Component Navigator, then click on the Format tab; 
this tab allows the user to select which style categories should be shown for controls in this component. 

Table background color not appearing in Designer
When you create a table, click the Format tab, and change the background color property, you cannot 
see the new background color when viewing the form in Designer. 

Table font changes not immediately appearing in Designer
When you create a table, add text to it, then change font properties in the Format tab, the changes do not 
appear until you close and re-open the form. 

Type validation is not working in edit/multiline edit box
Setting a schema type on an edit or multi-line edit control is not generating a runtime error message when 
an invalid type is entered into that control during runtime, and the subsequent submit event occurs. 

Typing over highlighted form text does not remove the text
The normal behavior for a text editor is to delete highlighted text automatically when new typing occurs; 
the Form Editor, however, does not implement this behavior. The text needs to be deleted manually, 
using the delete key, before entering new text. 

UI Control Styles preference settings are not applied
In the Designer preferences (File -> Preferences), the UI Control Styles preferences (Workplace Designer 
-> Forms -> UI Control Styles) currently are not applied, and have no effect. 

1. The UI Control type when dragging an element from the Data palette to a form is always determined by 
what is set as the default in the schema, and the option to prompt for the control type has no effect. 

2. Selecting a default layout and style for form Controls currently has no effect. To set a layout and style 
for a Control, use the Format tab on the control Properties after placing a control on the form. 

UNIX - libraries.xml is not modified in a cluster 
In UNIX installations, Java (JDK 1.3.1 and above) must be installed and included in the path. 
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Unwanted background color appears in FireFox
When you create a form with a panel, then deploy the component, a background color appears in the 
panel when viewing with the FireFox browser. 

View - Column - Lookup data is not working at runtime
Under some circumstances, it may appear that using a view lookup for a column value does not work. 
This occurs when users do not have a sortable column in the view in which they are doing the lookup. 

For example, if you are using a value in the current view to lookup a Zip Code field in a target view, the 
column that contains the zip codes in the target view should be sortable so the lookup can succeed. 

"All users" access in Roles is not honored 
When a Workplace Designer Built Collaborative Application is deployed to the Workplace Server, and 
after it is instantiated via Builder, then opened, the member page allows this selection: "Give All Users 
Access as: Contributor". This Public Access will not work; members of the Roles Contributor must be 
added individually. 

@DbLookup() function usage
When using the @DbLookup function, the view needs to have at least one sorted column. 

@Name() works in form; does not work in view column
As database deployment is done from the client side, some scripts that are relying on the Workplace API 
(like the directory) may not work. This is typically the case of @Name() which may call the directory API 
for some advanced features ([CN], [S], [G], [C], [O], [OUn], [ABBREVIATE]). 
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Documentation updates 

IBM Workplace Designer 

Choosing a location for an exported component
The component export dialog allows you to either browse to a file system location and enter a file name, 
or manually enter an absolute path in the file name field. If you only manually enter a file (without 
browsing), or enter a relative path, the file will be placed in the last selected directory used for a 
component export or import. This is a convenience that allows you to quickly export several components 
in succession without having to browse to, or enter, a directory path each time. 

However, if you have never exported, or imported, a component before, the last used directory defaults to 
a directory in your client workspace, so you should at least initially browse to a valid directory that you 
wish to export components to. The default initial export directory in the WMC client workspace is 
C:\Documents and Settings\<user name>\IBM\RCP\<client id>\<user 
name>\.metadata\.plugins\com.ibm.workplace.des.ide.ui. For example: C:\Documents and 
Settings\janedoe\IBM\RCP\723676099\janedoe\.metadata\.plugins\com.ibm.workplace.des.ide.ui. 

Configuring Workplace Designer to use with i5/OS
The following information about configuring Workplace Designer to use with i5/OS is missing from the 
documentation: 

Deploying an IBM® WorkplaceTM Designer component on i5/OSTM requires two additional steps that are not 
listed in the topics about deploying components. These steps include installing an additional JDBC driver 
and adding the appropriate database parameters to your deployment profile. 

Take the following steps: 

1.	 Locate the JDBC driver file called jt400.jar included with your i5/OS installation and copy it to the 
designer_install\applications\eclipse\plugins\com.ibm.workplace.designer.corelibs_1.0.0\jdbc 
directory, where designer_install is the Workplace Designer installation directory. 

2.	 Ask your system administrator to use STRSQL to create a schema with the CREATE SCHEMA 
schema-name SQL command, where schema-name is the name of the schema. This is the 
schema that will be used with Workplace Designer. 

Note: If you use CRTLIB to create the schema instead of STRSQL, you may get the following 
error message: java.sql.SQLException: [SQL7008] table_name in database_name not valid for 
operation.. You can resolve this by enabling journaling for your library and the tables contained in 
it. 
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3.	 In your deployment profile, in the Database section, fill in the following fields: 

a.	 In the Type field, select DB2 iSeries. 

b.	 Leave the Driver class field blank. It will default to 

com.ibm.as400.access.AS400JDBCDriver. 


c.	 In the URL field, type the URL of the form in this format: jdbc:as400://host/schema, 
where host is the name of the host and schema is the name of your schema. 

For more information about i5/OS, see the IBM eServerTM iSeriesTM Information Center at 
http://publib.boulder.ibm.com/infocenter/iseries/v5r3/ic2924/index.htm 

Database must already exist before deploying a component 
The topic "Databases" located in IBM Workplace Designer > Data is missing the following information: 

Regardless of your database type, you or your administrator must create a database or schema 
(depending on your database type) to use exclusively with Workplace Designer before you can 
successfully deploy a component. 

Date Picker option is missing in Help topic 
The topic "Setting Parameter properties for components" in IBM Workplace Designer > Components is 
missing information in step 3d. Here is the corrected step: 

Select whether the entry will be a Edit Box, Combo Box, or Date Picker (Date type only). 

DB2 support for Designer
This release note details how Designer can be configured to deploy to IBM Workplace servers that use a 
DB2 database. This does not include instructions for DB2 on iSeries. 

Additional Server Configuration 
For DB2 UDB 8.2, some server configuration is required to add a JAR containing additional DB2 classes 
to the classpath. These classes are not included, so .../ibm/sqlllib/java/db2jcc.jar needs to be added to 
the WAS system classpath. To do this: 

1.	 Log into the WAS admin console 
2.	 Navigate to Servers -> Application Servers -> WebSphere_Portal -> Process Definition -> Java 

Virtual Machine 
3.	 You should see a Classpath property that already contains a path to db2java.zip. Add an entry for 

db2jcc.jar in the same directory as db2java.zip 
4.	 Restart WPS. 
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Client-side (JDBC) Configuration 
DB2 supports a number of JDBC drivers each of which requires slightly different configuration both in 
Designer client and on the server. One driver is a pure Java driver that communicates directly with a 
JDBC server that is collocated with the DB2 server. The other consists of both Java and native code and 
communicates with the DB2 server via client-side proxy. These are often referred as the "net" (or JDBC 
type 4) and "app" (or JDBC type 2) drivers respectively. There's also a 3rd driver called the "universal 
driver" which is not currently fully supported by Designer. 

The "app" driver is typically preferred since its use of native code gives it much better performance, 
compared to the "net" driver. However, the "app" driver requires additional install and configuration steps 
on the client. It also contains native code which could potentially crash the JVM in certain error cases 
(although this is typically a rare occurrence). 

It is recommended that you review the following for more background information: 

Connectivity cheat sheet for Application Developers (Part 4)

Hooking Up with IBM DB2 Universal Database Version 8 Using Java


Configuring Designer to use the DB2 "app" driver 
Designer uses the "app" driver by default when DB2 is chosen as the database type. The configuration 

steps are as follows:.


z	 Install the DB2 Runtime Client. This is available from the DB2 support site. The runtime client 
contains the native code for the "app" driver, as well as certain configuration utilities that must be run 
in order to "catalog" the remote databases. With the "app" driver, a remote database is referenced 
via an "alias" rather than directly via hostname/database name. 

z	 Configure the catalog. Once the DB2 runtime client has been installed, you need to catalog the 
remote DB2 server to set up aliase(s) for the remote database(s). This procedure is documented in 
the "Hooking Up with IBM DB2 Universal Database Version 8 Using Java" link above.. 

Create the aliases. On the client machine go into the db2 command prompt by typing 'db2cmd' to 
open a command window and then 'db2' to enter the DB2 command interpreter. Run the following 
commands: 

catalog tcpip node <anynodenameyouwant> remote <your_remote_server> 

server 50000

catalog database <db_alias_name> at node <anynodenameyouwant>


The node name must be 8 characters or less. The node is just a local pointer to your remote 
database server. Name it, for example, "WPDES" for "workplace designer". Make sure you have the 
proper server name and domain for your server. If you did a default install of DB2, your server will be 
listening on port 50000. 

If you get an error indicating that a node or database alias already exists, perhaps from a previous 
run, you can see what nodes and databases you have cataloged. From a DB2 Command Line 
Processor, run "terminate", close the old DB2 CLP window, and open a new one. Then execute: 

list database directory


Check: After running this step you should be able to connect to the WPS50 databse from your client 
machine. Bring up a DB2 command window and execute: 

connect to <databasename> user <your_db2admin_acct> using 

<your_db2admin_password>
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z	 Install the JDBC driver ZIP file in the Designer JDBC directory. The JDBC driver ZIP is called 
db2java.zip and can be found in the DB2 install directory under ...\sqllib\java\db2java.zip. Copy this 
file to the 
<designer_install>\applications\eclipse\plugins\com.ibm.workplace.designer.corelibs_1.0.0\jdbc 
directory. It's extremely important that the zip file on the client and server match. Even a fixpack 
installed on the server can include a different version of the db2java.zip file. 

z	 Fill in the database parameters in the deploy profile. 
Database: DB2 
Driver Class: This can be left blank. The driver class defaults to COM.ibm.db2.jdbc.app.DB2Driver. 
URL: The URL is of the form jdbc:db2:<db_alias_name> where the db_alias_name was configured 
using the "catalog" command above. 

Configuring Designer to use the DB2 "net" driver 

z	 Install the JDBC driver ZIP file in the Designer JDBC directory. The JDBC driver ZIP is called 
db2java.zip and can be found in the DB2 install directory under ...\sqllib\java\db2java.zip. Copy this 
file to the 
<designer_install>\applications\eclipse\plugins\com.ibm.workplace.designer.corelibs_1.0.0\jdbc 
directory. It's extremely important that the zip file on the client and server match. Even a fixpack 
installed on the server can include a different version of the db2java.zip file. 

z	 Ensure that the JDBC (a/k/a JDBC Applet Server) service is running on the DB2 server.  The 
"net" driver communicates with this server--not directly with the DB2 server. This service can be 
started by issuing the "db2jstrt" command on the DB2 server. By default, the service listens on port 
6789. 

z	 Fill in the database parameters in the deploy profile 

Database: DB2

Driver Class: COM.ibm.db2.jdbc.net.DB2Driver

URL: The URL is of the form jdbc:db2://<host>:<port>/<dbname> e.g., 

jdbc:db2://myhost.notesdev.ibm.com:6789/mydb.


Troubleshooting 
The following is a list of possible errors you might encounter and their cause. You'll typically need to look 
a few levels into the stack trace in the "Details" pane of the deploy error dialog to find these errors. 

Error Possible cause 
java.lang.UnsatisfiedLinkError:SQLAllocEnv" You're using the "app" driver but you haven't 

installed the DB2 client runtime 
Error connecting to socket or Error opening socket Make sure the JDBC URL contains the correct 
or CLI0615E Error receiving from socket, server is hostname and port. If you're using the "net" driver, 
not responding. SQLSTATE=08S01 make sure the JDBC Applet service has been 

started on the DB2 server machine. 
CLI0621E Unsupported JDBC Server configuration. The db2java.zip file you installed in Designer is 

incompatible with the DB2 server. Make sure you 
obtained the db2java.zip file from the DB2 server 
installation. 
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Deploying to a clustered server environment
The documentation does not provide details about deploying to a clustered server environment. See the 
release note titled "Deploying a component manually" for details. 

Error in System requirements topic
The 'System requirements' topic lists "Microsoft Windows Mobile 2003" as one of the operating systems 
the Workplace Managed Client computer must have. This is incorrect, the "Microsoft Windows Mobile 
2003" OS is not supported in the current release. 

Importing a component and deployment
When importing a component, you have the option to "Preserve Deployment information" (default 

selection) or "Make a Copy". When you opt to preserve the deployment information, this allows whatever 

changes you make to the component to be immediately reflected on the server version when you deploy 

it. This, of course, assumes that the component has already been deployed on the server, perhaps by 

somebody you are collaborating with in the component design. If not, the option has no immediate effect. 

But it still may be very important to preserve the deployment info if you are collaborating with another 

designer who will be re-deploying the component after you initially deploy your version. 


If you choose the "Make a Copy" option, a completely new copy of the component will be generated. It 

will be "disconnected" from any currently existing version of the component, deployed or not. So, when 

you deploy the component it will always create a completely new instance on the server, even if the 

original component was already deployed. This may be of use if you are, for example, using the imported 

component as a base for a completely different component.


Note: When selecting to "Preserve Deployment information", you can not change the name of the 

component. Since it is essentially a replica of the original component, the name must remain as-is. If 

you do attempt to change the name, the option to preserve deployment information will be disabled, and 

the "Make a Copy" option will be automatically selected.


Incorrect command in help topic about configuring DB2 app

The topic "Configuring Workplace Designer to use DB2 app" in IBM Workplace Designer > Data > 

Databases has an incorrect command in step 4c. Here is the correct command:


catalog tcpip node <nodename> remote <servername> 50000

catalog database <alias> at node <nodename>
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Installation Guide errors 
Following are the known errors in the IBM Workplace Designer Installation Guide 

z	 All references to stopWorkplaceServices.bat [ or .sh], should be replaced by 
stopNetworkServer.bat [or .sh]. 

z	 In Step 11 of the topic "Installing Workplace Designer runtime files on a single server", the 
instructions for IBM iSeries should read: 

1. Navigate to /[WSE_HOME]or[WCS_HOME] /PortalServer/ rootscripts/subtasks, and run 

./startNetworkServer.sh

2. In the same directory, run ./startPortalServer.sh. 
3. Install the IBM Workplace Designer EAR file. 

You must start the Portal server before installing the EAR file. 

Label positions
For controls that have an attached label, there are two choices for the label position, "Left" and "Right". If 
the value is "Left", the label is positioned to the left of the control; if the value is "Right" the label is 
positioned to the right. 

Limitations of adding a component to a non-template-based page

The topic "Deploying components to a server" located in IBM Workplace Designer > Components > 

Deploying components does not describe the limitations of testing deployment by adding a component 

directly to a page without attaching it to a template. Here is the missing documentation:


If you test your component by adding it directly to a page without attaching it to a template, your 
component will not have the same functionality as a template-based component. For example, all 
instances of the component will share the same data, component parameters will not exist, user roles will 
not apply, and you will not be able to run scripts for instance lifecycle and membership. 

Manually deploying a component

The topic "Deploying components to a server" located in IBM Workplace Designer > Components > 

Deploying components does not describe how to deploy a component manually. Here is the missing 

documentation:


You can deploy IBM® WorkplaceTM Designer components manually. Manual deployment involves 

exporting the Workplace Designer component's Web ARchive (WAR) and Data Definition Language 

(DDL) files and manually deploying them to the appropriate server or servers. This process might be 

necessary if you are deploying in a production environment but don't have direct access to the IBM 

Workplace Collaboration Services server and/or database server. 


Note: Typically, after you export the WAR and DDL files, you will send them to your system and database 
administrators for them to deploy the WAR file and run the SQL script. Most likely, they will have all the 
required credentials necessary to access the servers and will already be familiar with deploying J2EE 
applications and setting up databases. 
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Prerequisites include the following: 
z	 a database (or schema, depending on the type of database) reserved for the Workplace Designer 

data store (see your database vendor's documentation for details) 
z	 clustered server environment only, databases reserved for Workplace Designer data stores must 

be cataloged on each application node in the cluster 
z	 clustered server environment only, a working installation of Workplace Designer in a networked 

environment (see the IBM Workplace Designer Installation Guide at http://www.lotus.com/ldd/doc 
for details) 

To perform manual deployment, take the following steps: 

1.	 Create a new Workplace Designer deployment profile (or edit an existing one) with the correct 
credentials and connection information for the target Workplace application and database 
servers. Both of these servers may be on the same machine. See Creating and editing 
deployment profiles for more information. 

2.	 Select the deployment profile that you want to use when deploying this component by taking the 
following steps: 

a.	 Click File > Preferences. 
b.	 Click Workplace Designer > Deployment. 
c.	 Click the radio button beside the deployment profile to make it the default profile. 
d.	 Click OK. 

3.	 Export the WAR and DDL files by taking the following steps: 

a.	 Click the component name in the Component Navigator. 
b.	 Click File > Export > .WAR file. 
c.	 In the Export WAR dialog box, specify the save location and name of the WAR file. 
d.	 Click Save. 
e.	 Click File > Export > .DDL file. 
f.	 In the Export DDL dialog box, specify the save location and name of the DDL file. 
g.	 Click Save. 

4.	 If you have deployed a component using this database before, your database administrator will 
need to edit the DDL's SQL script to remove the system table and index creation and initialization 
statements. To do this, take the following steps: 

a.	 Open the DDL file in an editor. 

b.	 Remove all the CREATE TABLE and CREATE INDEX statements that are located 
between the System tables and XML Database comments, for example: 

-- System tables


-- XML Database: Blog06280600
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c. Remove the first INSERT statement in the last section of the DDL file, for example: 

INSERT INTO FB__OBJ 

(FBTYPE,FBNAME,FBSUBTYPE,FBCREDAT,FBAUTHOR,FBMODDAT,FBLOCKED,FBDAT

A) VALUES ('ACLServer','ACLServer','',TO_DATE('1-7-2005 16:29:51', 

'DD-MM-YYYY HH24-MI-SS'),'anonymous',TO_DATE('1-7-2005 16:29:51', 

'DD-MM-YYYY HH24-MI-SS'),0,'<?xml version="1.0" 

encoding="UTF-8"?><ACLServer id="Obj-1" xmlns:SOAP-ENC="

http://schemas.xmlsoap.org/soap/encoding/" xmlns:xsd="

http://www.w3.org/1999/XMLSchema/instance/" xmlns:xsi="

http://www.w3.org/1999/XMLSchema/" xmlns:fb="

http://www.flowbuilder.com/namespaces/datatypes

"><maxQueryFields>60</maxQueryFields><perInstance>true</perInstanc

e><tbSeqID>1</tbSeqID><version>5</version></ACLServer>');


5.	 Ask your database administrator to create the component data store by running the SQL script 
according to the database vendor's documentation. Note that this step does not create the 
database for you. See the prerequisites above. 

6.	 Ask your system administrator to deploy the WAR file to the IBM Workplace Collaboration 
Services server, using a standard method such as the IBM WebSphere® Portal administrative 
user interface or XMLAccess scripts. 

If you are deploying in a clustered server environment, you will need to perform these additional 
two steps: 
z	 Before deploying the WAR file, add the following property to the global.properties file in 

the WAR file: 
fb.xsp.documentpool.directory=<shared_directory>

where <shared_directory> is the full path to the shared directory. 

z	 After deploying the WAR file, replicate your WebSphere Portal applications to all 
application nodes in the cluster. Use the WebSphere Portal documentation to perform 
this task. 

7.	 If you have defined any parameters for your component using the Parameters tab in the 
Properties panel, ask your system administrator to take the following steps. If you have not 
defined any parameters, you can bypass this step. 

a.	 Unzip the component's WAR file that you exported earlier. 

b.	 Locate the file that has the same name as your component. For example, if the name of 
your component is ProjectManager, locate the file called ProjectManager (without a file 
extension). 

c.	 Copy the file to your clipboard. 

d.	 Paste the file into the 
\WebSphere\AppServer\installedApps\<cell-name>\wps.ear\wps.war directory, where 
<cell-name> is the cell name of the application server. 

Note: If you have defined parameters for the component and therefore had to follow 
these steps, you will need to create a new Workplace template for the component 
application. Existing templates will not recognize the new file that you just added to the 
wps.war directory. 
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8. Test your deployment by taking one of the following actions. 

z	 Create an application instance from an existing Workplace template and add the 
component to a page in that application. 

z	 Create a new Workplace template, set up an application based on that template, and 
then add the component to a page in the application. 

z	 Add your component directly to a page without attaching it to a template. Note: If you test 
your component this way, your component will not have the same functionality as a 
template-based component. For example, all instances of the component will share the 
same data, component parameters will not exist, user roles will not apply, and you will 
not be able to run scripts for instance lifecycle and membership. 

Sample application component help
The following text should be included in the topic "Sample components": 

Perform the following steps to import the sample applications into Workplace Designer: 
1. Click File > Import > Component. 
2. In the Import Workplace Component dialog box, click Browse. 
3. Navigate to one of the following directories:
z	 [WMCInstallDir]\applications\eclipse\plugins\com.ibm.workplace.designer.sampleApps_1.0.0\sam 

pleApps (Microsoft® Windows®) 
z	 [WMCInstallDir]/applications/eclipse/plugins/com.ibm.workplace.designer.sampleApps_1.0.0/sam 

pleApps (Linux™). 

Note: [WMCInstallDir] is the directory where the IBM Workplace Managed Client is installed.


4. Select one of the following .JAR files, and then click Open.
ProjectManager.jar 

DiscussionDatabase.jar 

ContactList.jar 

Blog.jar 


5. Click OK. 

The following text should be in the topic "Porject Manager": 

Two script libraries provide the logic: 
z	 NavigationScripts - These scripts save the current document, open a new response document, 

delete the current document, open a view, and open the parent document. 
z	 ProjectValues - These scripts manipulate the display of an image based on certain values, and 

determine the role assigned to the current user. 

The following text should be in the topic "Discussion Database": 

Three script libraries provide the logic: 
z	 scriptLibraryFormat - These scripts format dates and assembles strings. 
z	 scriptLibraryNavigation - These scripts assemble runtime URLs and redirects to them. 
z	 scriptLibraryStringConstants - These scripts return string constants. 
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Setting form data properties topic 
The Document action property in the form properties Data tab is documented like this: 

"New Document - A new document is created with its own ID each time users open the form. You must 
create a script that produces an ID for each new document in the Parent ID field. Users must have Author 
or Editor component level access in order to create new documents. 

Note Since users with Reader component level access cannot create new documents, they cannot open 
this form. If the form contains a view that you want Readers to access, you can uncheck "Specify a data 
source for this form." After this is unchecked however, you cannot store data entered into this form." 

The note is incorrect. If you uncheck "Specify a data source for this form" so that users with Reader 
access can see the form, you can still store user data in documents. You must add a panel control (or 
controls) to the form and put the controls that accept data into that panel. Then in the panel's Data 
properties you select "Specify a data source for this form" and set the panel to generate a document. The 
form will not generate a document, but the panel will. 

Suggestions for testing deployment, including limitations 
The topic "Deploying components to a server" located in IBM Workplace Designer > Components > 
Deploying components does not describe in enough detail how to test component deployment once it is 
completed. Here is the missing documentation: 

Test your deployment by taking one of the following actions: 

z	 Create an application instance from an existing Workplace template and add the 
component to a page in that application. 

z	 Create a new Workplace template, set up an application based on that template, and 
then add the component to a page in the application. 

z	 Add your component directly to a page without attaching it to a template. Note: If you test 
your component this way, your component will not have the same functionality as a 
template-based component. For example, all instances of the component will share the 
same data, component parameters will not exist, user roles will not apply, and you will 
not be able to run scripts for instance lifecycle and membership. 

Tutorial: /project/status should be /project/currentStatus
The following error occurs in the Tutorial section of the Workplace Designer reference help: 

Step 7 in the topic "Creating a component and schema" lists a completed schema including a 
currentStatus element. 

Step 21 in the topic "Creating a form for listing documents" includes the statement: 

var status = document.getIntValue("/project/status"); 

This statement references the currentStatus element and should therefore be: 

var status = document.getIntValue("/project/currentStatus"); 

24 



IBM Workplace Designer 2.5 Release Notes 

Notices and Trademarks 

Notices 

Notices 
This information was developed for products and services offered in the USA. IBM may not offer the 
products, services, or features discussed in this document in all countries. Consult your local IBM 
representative for information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country/region or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 

The following paragraph does not apply to the United Kingdom or any other country/region where such 
provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, 
this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product, and use of those Web sites is at your own risk. 
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IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information that has been exchanged, should contact: 

Lotus Software 
IBM Software Group 
One Rogers Street 
Cambridge, MA 02142 
USA 

Such information may be available, subject to appropriate terms and conditions, including in some cases 
payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems, and there is no guarantee that these measurements will be 
the same on generally available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements, or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 

Excluded Components information
Information included in this section relates to certain "Excluded Components"; the terms governing usage 
of Excluded Components are as set forth in the IBM product license. Pursuant to the licenses under 
which IBM has obtained the Excluded Components, IBM is required to provide the following copyright 
notices and information. They are provided for informational purposes only, and do not change the terms 
of the IBM product license. 
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FileUpload 1.0 License
Apache License 
Version 2.0, January 2004 
http://www.apache.org/licenses/ 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document. 
"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License. 
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity. For the purposes of this definition, "control" means 
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by 
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) 
beneficial ownership of such entity. 
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License. 
"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files. 
"Object" form shall mean any form resulting from mechanical transformation or translation of a 
Source form, including but not limited to compiled object code, generated documentation, and 
conversions to other media types. 
"Work" shall mean the work of authorship, whether in Source or Object form, made available under 
the License, as indicated by a copyright notice that is included in or attached to the work (an example 
is provided in the Appendix below). 
"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or 
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other 
modifications represent, as a whole, an original work of authorship. For the purposes of this License, 
Derivative Works shall not include works that remain separable from, or merely link (or bind by name) 
to the interfaces of, the Work and Derivative Works thereof. 
"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity 
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" 
means any form of electronic, verbal, or written communication sent to the Licensor or its 
representatives, including but not limited to communication on electronic mailing lists, source code 
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for 
the purpose of discussing and improving the Work, but excluding communication that is 
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a 
Contribution." 
"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work. 

2. Grant of Copyright License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, 
worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare 
Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such 
Derivative Works in Source or Object form. 
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3. Grant of Patent License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, 
worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent 
license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such 
license applies only to those patent claims licensable by such Contributor that are necessarily infringed 
by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such 
Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim 
or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work 
constitutes direct or contributory patent infringement, then any patent licenses granted to You under this 
License for that Work shall terminate as of the date such litigation is filed. 

4. Redistribution.

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or 
without modifications, and in Source or Object form, provided that You meet the following conditions: 

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; 
and 

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, 
patent, trademark, and attribution notices from the Source form of the Work, excluding those notices 
that do not pertain to any part of the Derivative Works; and 

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE 
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of 
the following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear. The 
contents of the NOTICE file are for informational purposes only and do not modify the License. You 
may add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License. You may add Your own copyright statement to Your 
modifications and may provide additional or different license terms and conditions for use, 
reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, 
provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions 
stated in this License. 

5. Submission of Contributions.

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by 
You to the Licensor shall be under the terms and conditions of this License, without any additional terms 
or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any 
separate license agreement you may have executed with Licensor regarding such Contributions. 

6. Trademarks.

This License does not grant permission to use the trade names, trademarks, service marks, or product 
names of the Licensor, except as required for reasonable and customary use in describing the origin of 
the Work and reproducing the content of the NOTICE file. 
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7. Disclaimer of Warranty.

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR 
CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or 
conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR 
PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License. 

8. Limitation of Liability.

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, 
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, 
shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or 
consequential damages of any character arising as a result of this License or out of the use or inability to 
use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure 
or malfunction, or any and all other commercial damages or losses), even if such Contributor has been 
advised of the possibility of such damages. 

9. Accepting Warranty or Additional Liability.

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, 
acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this 
License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole 
responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold 
each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by 
reason of your accepting any such warranty or additional liability. 

END OF TERMS AND CONDITIONS 

APPENDIX 
How to apply the Apache License to your work. 

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed 
by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text 
should be enclosed in the appropriate comment syntax for the file format. We also recommend that a file 
or class name and description of purpose be included on the same "printed page" as the copyright notice 
for easier identification within third-party archives. Copyright [yyyy] [name of copyright owner] Licensed 
under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance 
with the License. You may obtain a copy of the License at 

http://www.apache.org/licenses/LICENSE-2.0 

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied. See the License for the specific language governing permissions and limitations 
under the License. 
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Jaxen 1.0 License 
$Id: LICENSE.txt,v 1.3 2003/06/29 18:22:02 ssanders Exp $
 Copyright 2003 (C) The Werken Company. All Rights Reserved.

 Redistribution and use of this software and associated documentation ("Software"), with or without 
modification, are permitted provided that the following conditions are met: 

1.	 Redistributions of source code must retain copyright statements and notices. Redistributions must 
also contain a copy of this document. 

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution. 

3.	 The name "jaxen" must not be used to endorse or promote products derived from this Software 
without prior written permission of The Werken Company. For written permission, please contact 
bob@werken.com. 

4.	 Products derived from this Software may not be called "jaxen" nor may "jaxen" appear in their names 
without prior written permission of The Werken Company. "jaxen" is a registered trademark of The 
Werken Company. 

5.	 Due credit should be given to The Werken Company (http://jaxen.werken.com/). 

THIS SOFTWARE IS PROVIDED BY THE WERKEN COMPANY AND CONTRIBUTORS ``AS IS'' AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE WERKEN COMPANY OR ITS CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
 */ 
© 2001-2004, Codehaus 

JDOM 1.0 License 
Copyright (C) 2000 Brett McLaughlin & Jason Hunter.
 All rights reserved.

 Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

1.	 Redistributions of source code must retain the above copyright notice, this list of conditions, and the 
following disclaimer. 

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and 
the disclaimer that follows these conditions in the documentation and/or other materials provided with 
the distribution. 

3.	 The name "JDOM" must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact license@jdom.org. 

4.	 Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their 
name, without prior written permission from the JDOM Project Management (pm@jdom.org). 
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5.	 If appropriate, the end-user documentation included with the redistribution and/or the software itself 
must include a text acknowledgement equivalent to the following: 

"This product includes software developed by the JDOM Project (http://www.jdom.org/)." 

Alternatively, the acknowledgment may be graphical using the logos available at 
http://www.jdom.org/images/logos.

 THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE 
SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of the JDOM Project 
and was originally created by Brett McLaughlin <brett@jdom.org> and Jason Hunter 
<jhunter@jdom.org>. For more information on the JDOM Project, please see <http://www.jdom.org/>.

 */ 

Lucene 1.3 License 
Apache License Version 2.0, January 2004
 http://www.apache.org/licenses/ 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document. 

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the 
License. 

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, 
or are under common control with that entity. For the purposes of this definition, "control" means (i) the 
power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity. "You" (or "Your") shall mean an individual or Legal Entity exercising 
permissions granted by this License. 

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files. 

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types. 
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"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below). 

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof. 

"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to 
submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form 
of electronic, verbal, or written communication sent to the Licensor or its representatives, including but 
not limited to communication on electronic mailing lists, source code control systems, and issue tracking 
systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving 
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing 
by the copyright owner as "Not a Contribution." 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has 
been received by Licensor and subsequently incorporated within the Work. 

2. Grant of Copyright License.
Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, 

worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare 

Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such 

Derivative Works in Source or Object form.


3. Grant of Patent License.
Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, 

worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent 

license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such 

license applies only to those patent claims licensable by such Contributor that are necessarily infringed 

by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such 

Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim 

or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work 

constitutes direct or contributory patent infringement, then any patent licenses granted to You under this 

License for that Work shall terminate as of the date such litigation is filed.


4. Redistribution.
You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or 

without modifications, and in Source or Object form, provided that You meet the following conditions:


(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; 
and 

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, 
patent, trademark, and attribution notices from the Source form of the Work, excluding those notices 
that do not pertain to any part of the Derivative Works; and 
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(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that 
You distribute must include a readable copy of the attribution notices contained within such NOTICE 
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of 
the following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear. The 
contents of the NOTICE file are for informational purposes only and do not modify the License. You 
may add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot 
be construed as modifying the License. You may add Your own copyright statement to Your 
modifications and may provide additional or different license terms and conditions for use, 
reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, 
provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions 
stated in this License. 

5. Submission of Contributions.
Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by 
You to the Licensor shall be under the terms and conditions of this License, without any additional terms 
or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any 
separate license agreement you may have executed with Licensor regarding such Contributions. 

6. Trademarks.
This License does not grant permission to use the trade names, trademarks, service marks, or product 
names of the Licensor, except as required for reasonable and customary use in describing the origin of 
the Work and reproducing the content of the NOTICE file. 

7. Disclaimer of Warranty.
Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR 
CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or 
conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR 
PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the 
Work and assume any risks associated with Your exercise of permissions under this License. 

8. Limitation of Liability.
In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, 
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, 
shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or 
consequential damages of any character arising as a result of this License or out of the use or inability to 
use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure 
or malfunction, or any and all other commercial damages or losses), even if such Contributor has been 
advised of the possibility of such damages. 

9. Accepting Warranty or Additional Liability.
While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, 
acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this 
License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole 
responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold 
each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by 
reason of your accepting any such warranty or additional liability. 

END OF TERMS AND CONDITIONS 
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APPENDIX 
How to apply the Apache License to your work. 

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed 
by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text 
should be enclosed in the appropriate comment syntax for the file format. We also recommend that a file 
or class name and description of purpose be included on the same "printed page" as the copyright notice 
for easier identification within third-party archives. 

Copyright [yyyy] [name of copyright owner] Licensed under the Apache License, Version 2.0 (the 
"License"); you may not use this file except in compliance with the License. You may obtain a copy of 
the License at http://www.apache.org/licenses/LICENSE-2.0 

Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied. See the License for the specific language governing permissions and limitations 
under the License. 

RegExp 1.3 License
Copyright (c) 1995-1999 The Apache Group. 
All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 
1.	 Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution. 

3.	 All advertising materials mentioning features or use of this software must display the following 
acknowledgment: 

"This product includes software developed by the Apache Group for use in the Apache HTTP server 
project(http://www.apache.org/)." 

4.	 The names "Apache Server" and "Apache Group" must not be used to endorse or promote products 
derived from this software without prior written permission. For written permission, please contact 
apache@apache.org. 

5.	 Products derived from this software may not be called "Apache" nor may "Apache" appear in their 
names without prior written permission of the Apache Group. 

6.	 Redistributions of any form whatsoever must retain the following acknowledgment: "This product 
includes software developed by the Apache Group for use in the Apache HTTP server project ( 
http://www.apache.org/)." 
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THIS SOFTWARE IS PROVIDED BY THE APACHE GROUP ``AS IS'' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE APACHE GROUP OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. 

==================================================================== 
This software consists of voluntary contributions made by many individuals on behalf of the Apache 
Group and was originally based on public domain software written at the National Center for 
Supercomputing Applications, University of Illinois, Urbana-Champaign. For more information on the 
Apache Group and the Apache HTTP server project, please see <http://www.apache.org/>. 

wcp-wts-sdk 1.03M license
Eclipse Public License - v 1.0 
THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS ECLIPSE PUBLIC 
LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF THE PROGRAM 
CONSTITUTES RECIPIENT'S ACCEPTANCE OF THIS AGREEMENT. 

1. DEFINITIONS

"Contribution" means: 

a) in the case of the initial Contributor, the initial code and documentation distributed under this 
Agreement, and 

b) in the case of each subsequent Contributor: 

i) changes to the Program, and 

ii) additions to the Program; 

where such changes and/or additions to the Program originate from and are distributed by that particular 
Contributor. A Contribution 'originates' from a Contributor if it was added to the Program by such 
Contributor itself or anyone acting on such Contributor's behalf. Contributions do not include additions to 
the Program which: (i) are separate modules of software distributed in conjunction with the Program 
under their own license agreement, and (ii) are not derivative works of the Program. 

"Contributor" means any person or entity that distributes the Program. 

"Licensed Patents " mean patent claims licensable by a Contributor which are necessarily infringed by the 
use or sale of its Contribution alone or when combined with the Program. 

"Program" means the Contributions distributed in accordance with this Agreement. 

"Recipient" means anyone who receives the Program under this Agreement, including all Contributors. 

2. GRANT OF RIGHTS 

a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, 
worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display, 
publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such 
derivative works, in source code and object code form. 
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b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive, 
worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and 
otherwise transfer the Contribution of such Contributor, if any, in source code and object code form. This 
patent license shall apply to the combination of the Contribution and the Program if, at the time the 
Contribution is added by the Contributor, such addition of the Contribution causes such combination to be 
covered by the Licensed Patents. The patent license shall not apply to any other combinations which 
include the Contribution. No hardware per se is licensed hereunder. 

c) Recipient understands that although each Contributor grants the licenses to its Contributions set forth 
herein, no assurances are provided by any Contributor that the Program does not infringe the patent or 
other intellectual property rights of any other entity. Each Contributor disclaims any liability to Recipient 
for claims brought by any other entity based on infringement of intellectual property rights or otherwise. 
As a condition to exercising the rights and licenses granted hereunder, each Recipient hereby assumes 
sole responsibility to secure any other intellectual property rights needed, if any. For example, if a third 
party patent license is required to allow Recipient to distribute the Program, it is Recipient's responsibility 
to acquire that license before distributing the Program. 

d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if 
any, to grant the copyright license set forth in this Agreement. 

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own license agreement, 
provided that: 

a) it complies with the terms and conditions of this Agreement; and 

b) its license agreement: 

i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and 
implied, including warranties or conditions of title and non-infringement, and implied warranties or 
conditions of merchantability and fitness for a particular purpose; 

ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, 
indirect, special, incidental and consequential damages, such as lost profits; 

iii) states that any provisions which differ from this Agreement are offered by that Contributor 
alone and not by any other party; and 

iv) states that source code for the Program is available from such Contributor, and informs 
licensees how to obtain it in a reasonable manner on or through a medium customarily used for 
software exchange. 

When the Program is made available in source code form: 

a) it must be made available under this Agreement; and 

b) a copy of this Agreement must be included with each copy of the Program. 

Contributors may not remove or alter any copyright notices contained within the Program. 

Each Contributor must identify itself as the originator of its Contribution, if any, in a manner that 
reasonably allows subsequent Recipients to identify the originator of the Contribution. 
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4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to end users, 
business partners and the like. While this license is intended to facilitate the commercial use of the 
Program, the Contributor who includes the Program in a commercial product offering should do so in a 
manner which does not create potential liability for other Contributors. Therefore, if a Contributor includes 
the Program in a commercial product offering, such Contributor ("Commercial Contributor") hereby 
agrees to defend and indemnify every other Contributor ("Indemnified Contributor") against any losses, 
damages and costs (collectively "Losses") arising from claims, lawsuits and other legal actions brought by 
a third party against the Indemnified Contributor to the extent caused by the acts or omissions of such 
Commercial Contributor in connection with its distribution of the Program in a commercial product 
offering. The obligations in this section do not apply to any claims or Losses relating to any actual or 
alleged intellectual property infringement. In order to qualify, an Indemnified Contributor must: a) promptly 
notify the Commercial Contributor in writing of such claim, and b) allow the Commercial Contributor to 
control, and cooperate with the Commercial Contributor in, the defense and any related settlement 
negotiations. The Indemnified Contributor may participate in any such claim at its own expense. 

For example, a Contributor might include the Program in a commercial product offering, Product X. That 
Contributor is then a Commercial Contributor. If that Commercial Contributor then makes performance 
claims, or offers warranties related to Product X, those performance claims and warranties are such 
Commercial Contributor's responsibility alone. Under this section, the Commercial Contributor would 
have to defend claims against the other Contributors related to those performance claims and warranties, 
and if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor 
must pay those damages. 

5. NO WARRANTY 

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON AN 
"AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR 
IMPLIED INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each 
Recipient is solely responsible for determining the appropriateness of using and distributing the Program 
and assumes all risks associated with its exercise of rights under this Agreement , including but not 
limited to the risks and costs of program errors, compliance with applicable laws, damage to or loss of 
data, programs or equipment, and unavailability or interruption of operations. 

6. DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY 
CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION 
LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY 
RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

7. GENERAL 

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the 
validity or enforceability of the remainder of the terms of this Agreement, and without further action by the 
parties hereto, such provision shall be reformed to the minimum extent necessary to make such provision 
valid and enforceable. 

If Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a 
lawsuit) alleging that the Program itself (excluding combinations of the Program with other software or 
hardware) infringes such Recipient's patent(s), then such Recipient's rights granted under Section 2(b) 
shall terminate as of the date such litigation is filed. 
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All Recipient's rights under this Agreement shall terminate if it fails to comply with any of the material 
terms or conditions of this Agreement and does not cure such failure in a reasonable period of time after 
becoming aware of such noncompliance. If all Recipient's rights under this Agreement terminate, 
Recipient agrees to cease use and distribution of the Program as soon as reasonably practicable. 
However, Recipient's obligations under this Agreement and any licenses granted by Recipient relating to 
the Program shall continue and survive. 

Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid inconsistency 
the Agreement is copyrighted and may only be modified in the following manner. The Agreement Steward 
reserves the right to publish new versions (including revisions) of this Agreement from time to time. No 
one other than the Agreement Steward has the right to modify this Agreement. The Eclipse Foundation is 
the initial Agreement Steward. The Eclipse Foundation may assign the responsibility to serve as the 
Agreement Steward to a suitable separate entity. Each new version of the Agreement will be given a 
distinguishing version number. The Program (including Contributions) may always be distributed subject 
to the version of the Agreement under which it was received. In addition, after a new version of the 
Agreement is published, Contributor may elect to distribute the Program (including its Contributions) 
under the new version. Except as expressly stated in Sections 2(a) and 2(b) above, Recipient receives no 
rights or licenses to the intellectual property of any Contributor under this Agreement, whether expressly, 
by implication, estoppel or otherwise. All rights in the Program not expressly granted under this 
Agreement are reserved. 

This Agreement is governed by the laws of the State of New York and the intellectual property laws of the 
United States of America. No party to this Agreement will bring a legal action under this Agreement more 
than one year after the cause of action arose. Each party waives its rights to a jury trial in any resulting 
litigation. 

XMLS 0.8 License 
Copyright (c) 2001, Sosnoski Software Solutions, Inc. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
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Trademarks 

Trademark list 
IBM, the IBM logo, Domino, Lotus, Notes, WebSphere, Workplace, and Workplace Managed Client are 
trademarks or registered trademarks of International Business Machines Corporation in the United 
States, other countries, or both. 

Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both. 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States, other 

countries, or both.


UNIX is a registered trademark of The Open Group in the United States and other countries.


Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun 

Microsystems, Inc. in the United States, other countries, or both.


Other company, product, or service names may be trademarks or service marks of others.
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